
 

 

What’s New 

Sage UBS version 9.9.5.0 Build 102  

Release Date:   

7th August 2020 

 

Important Note 

• You will need to disable your Anti-virus before you install the new update as some Anti-virus can interfere and 

prevent a successful installation. 

• After successfully installing the update (whether via Online Update or using the Installer), you must restart your 

computer for the configuration changes to take effect. 

 

V9.9.5.0 Updates 

The following enhancements are being released: 

Modern View 

• Landing Page 

• Accounting Module 

o Homepage 

o Transaction 

• Inventory & Billing Module 

o Homepage 

o Transaction 

 

 

Payment Cloud/Invoice Payments 

• Setup & Onboarding 

  

 

V9.9.5.0 Build 101 Updates 

Useful Fixes 

• SAA1-1512 

• SAA1-1513 

 

 

V9.9.5.0 Build 102 Updates 

Useful Fixes 

• SAA1-1517 

• SAA1-1518 

  



Sage UBS  ◄2 
   

222  

Contents 
1 Modern View .................................................................................................................................................. 3 
2 Landing Page ................................................................................................................................................. 3 
3 Accounting Module ........................................................................................................................................ 4 

3.1 Switch to Modern View ......................................................................................................................... 4 

3.2 Modern View – Homepage ................................................................................................................... 4 

4 Inventory & Billing Module ............................................................................................................................. 5 
4.1 Switch to Modern View ......................................................................................................................... 5 

4.2 Modern View – Homepage ................................................................................................................... 5 

4.3 Modern View – Transaction .................................................................................................................. 6 

4.4 Quick Steps ........................................................................................................................................... 6 

4.4.1 Switch transaction type ................................................................................................................. 6 

4.4.2 Tabs .............................................................................................................................................. 7 

4.4.3 Action icons ................................................................................................................................... 7 

4.4.4 Customize Transaction Body Column........................................................................................... 8 

4.4.5 Delete or Insert item line ............................................................................................................... 8 

Payment Cloud/Invoice Payments ........................................................................................................................ 9 
1. Customer Journey ......................................................................................................................................... 9 
2. How it works .................................................................................................................................................. 9 
3. Getting started ............................................................................................................................................. 10 

3.1 Welcome message ............................................................................................................................. 10 

3.2  New labels........................................................................................................................................... 10 

3.2.1 Accounting .................................................................................................................................. 10 

3.2.2 Inventory & Billing ....................................................................................................................... 11 

3.3  Service Providers ................................................................................................................................ 12 

3.4 Onboarding process ............................................................................................................................ 12 

3.4.1 Steps ........................................................................................................................................... 12 

3.4.2  Disclaimer ................................................................................................................................... 13 

3.4.3 PayPal ......................................................................................................................................... 14 

3.4.4 Stripe ........................................................................................................................................... 17 

3.5  Set up after Onboarding ...................................................................................................................... 21 

3.5.1  Payment Providers Management................................................................................................ 21 

3.5.2  Payment Link Settings ................................................................................................................ 22 

3.6  Email Invoice with payment link .......................................................................................................... 23 

3.6.1  Select an invoice to email ........................................................................................................... 23 

3.6.2  Email the Invoice with payment link ............................................................................................ 23 

3.6.3  Resending Email with updated info............................................................................................. 24 

3.7  Get Paid .............................................................................................................................................. 24 

3.7.1  Check email (Customer side) ...................................................................................................... 24 

3.7.2  Making payment (Customer side) ............................................................................................... 25 

3.8 Check Status ....................................................................................................................................... 25 

3.8.1 Invoice Payment Listing .............................................................................................................. 25 

3.8.2 Generate Receipts ...................................................................................................................... 27 

3.8.3 Edit Receipts ............................................................................................................................... 30 

Useful Fixes ........................................................................................................................................................ 31 
 



Sage UBS  ◄3 
   

333  

1 Modern View 

Modern View has been introduced to provide better user experience in both Sage UBS Accounting and Sage UBS Inventory & 

Billing.  Besides the new user interface, we also introduced a completely new process workflow in Inventory & Billing module 

to give you better navigation and access with less steps to create your transactions under an improved holistic view. 

 

2 Landing Page 

The makeover Landing Page now comes with the following upgrades: 

a. Improved filtering and searching capabilities on company list, 

b. Settings is now made more visible and structured to ease your maintenance tasks on system and company level, 

c. Ability to set/mark your frequently accessed companies as favorites for quick direct access 

d. Visible action buttons for you to manage your tasks easily 
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3 Accounting Module 

3.1 Switch to Modern View 

 

In Accounting module, you can click on the Switch to Modern View button available at the top bar on the right.  In view of 

your comfort and preference in managing your tasks in Classic view while you explore the new workflow provided in Modern 

view, you have the option and the flexibility to switch between Classic  Modern view anytime to your comfort.  As 

both Classic and Modern are sharing same database, the create, edit and view will provide the same result in both Classic and 

Modern view, only presentation with a difference! 

Under multi-user mode, individual user can select own preferred view to work on the system.   

 

3.2 Modern View – Homepage 

Important Note: As all menus are regrouped in the Modern view, you are highly advised to revisit the User Defined Menu 

and re-assign rights to the respective user as deemed necessary.  

 

The new Homepage in Accounting now comes with the following upgrades: 

a. Regrouping of menu item with reduced level for ease of selection and managing tasks, 

b. Working panel is well structured into three sections for distinct visibility of information: 

i. Left Panel -  grouping of similar functions to provide clarity and ease of access  

ii. Middle Panel -  process tasks spread over to Maintenance [top], Workflow [middle] and Related Tasks 

[bottom] 

iii. Right Panel -  Related data / information 

c. Action buttons are more visible on the top bar for your direct access without having to leave the page 
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4 Inventory & Billing Module 

4.1 Switch to Modern View 

 

Same improvements made in Inventory & Billing where you can click on the Switch to Modern View button available at the 

top bar on the right.  In view of your comfort and preference in managing your tasks in Classic view while you explore the new 

workflow provided in Modern view, you have the option and the flexibility to switch between Classic  Modern view 

anytime to your comfort.  As both Classic and Modern are sharing same database, the create, edit and view will provide the 

same result in both Classic and Modern view, only presentation with a difference! 

Under multi-user mode, individual user can select own preferred view to work on the system.   

 

4.2 Modern View – Homepage 

Important Note: As all menus are regrouped in the Modern view, you are highly advised to revisit the User Defined Menu and 

re-assign rights to the respective user as deemed necessary.  

 

 

The new Homepage in Inventory and Billing now comes with the following upgrades: 

a. Regrouping of menu item with reduced level for ease of selection and managing tasks, 

b. Working panel is well structured into three sections for distinct visibility of information: 

i. Left Panel -  process menu to provide clarity on types of transactions 

ii. Middle Panel -  process tasks spread over to Maintenance [top], Workflow [middle] and Related Tasks 

[bottom] 

iii. Right Panel -  Related data / information 

c. Action buttons are more visible on the top bar for your direct access without having to leave the page 
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4.3 Modern View – Transaction 

The transaction now comes with three (3) different modes to conveniently suit your tasks management: 

a. Add –  If you are making a Sales Invoice entry, at the transaction window title bar, you will see the label displaying Add 

Sales Invoice.  All other action icons like Search, Print, Preview, Email, Export, Delete and Edit icons are hidden to 

avoid unwanted interference to the incomplete new transaction. 

b. View – If you are viewing a Sales Invoice record, at the transaction window title bar, you will see the label displaying View 

Sales Invoice.  While editing is not allowed under view mode; you can still click on all other action icons like Search, 

Print, Preview, Email, Export, Delete and Edit icons to perform required action.  If you would like to create new 

transaction, you can simply click on                    button to switch to add mode. 

c. Edit – If you wish to edit a Sales Invoice record, you can click on         icon at the top right corner in transaction window to 

turn on edit mode.  When you are editing a Sales Invoice record, at the transaction window title bar, you will see the 

label displaying Edit Sales Invoice.  All other action icons like Search, Print, Preview, Email, Export, Delete and Edit 

are hidden to avoid unwanted interference to the transaction being edited. 

 

 

4.4 Quick Steps 

The transaction screen is now equipped with some quick steps to provide flexibility and help speed up your entry with ease 

with direct switch and/or access to other screens for additional information input as required.  

4.4.1 Switch transaction type 

Flexibility is the key when it comes to data entry with minimal steps to gain speed and minimize errors. Enjoy all these 

positive traits with the newly introduced Switch Transaction Type function! 

Simply click on the drop-down menu of your current transaction type to change without having to close the transaction 

window.  Do take note that you can only switch between transaction type of the same category.  For example, in the 

sales invoice window, you can easily switch to any other sales transaction window; while in purchase invoice window, you 

can switch to any other purchase transaction window. 
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4.4.2 Tabs 

Three tabs were added to provide you ease of direct access to input your additional information to the transaction being 

created or edited. Each tab contains different set of information for the transaction, as and when required.  

a. Detail tab –  allows you to enter / view common information for your transaction, such as transaction date, 

reference number, customer / supplier number, etc. This is the main page for all required 

information on the transaction 

b. Additional tab – allows you to enter / view other information required for the transaction 

 
 

c. Remarks tab – allows you to enter / view header and footer remarks required for the transaction 

 

 

 

4.4.3 Action icons 

Action icons are added for your convenience and to help you manage your entry process more efficiently 

 – click on it to Search transaction 

 – click on it to Print transaction 

 
– click on it to Preview transaction 

 
– click on it to Email transaction (if applicable) 

 
– click on it to Export transaction to another file format 

 
– click on it to Delete transaction 

 
– click on it to Edit transaction 
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4.4.4 Customize Transaction Body Column  

Addressing individual user preference of an entry flow for speed and reduced errors, we have incorporated customizable 

columns in body section of the transaction screen. This will fully support every individual user to work with ease and 

comfort on their own customized columns to ease entry flow. 

 

• You can add or remove column by selecting the column and click on Add or Remove button.  You may also double 

click on the column name to perform the same action. 

• If you would like to change the position / sequence of the column, you can click on Move Up or Move Down 

button. 

• Wish to discard all your changes? Easy! You can click on Reset to Defaults button to follow system default column 

to start afresh. 

• Note: The customization of the columns in body section is independent of individual user and transaction.  In short, 

changing of column(s) for User A will not affect the column(s) set by User B. 

 

4.4.5 Delete or Insert item line 

Multiple options are introduced to help you manage the item lines with ease during transaction input: 

• You can delete or insert item line by clicking on the relevant action button located at the bottom body section 

  

• You may also select the item line and right click on the body section to prompt the action list and perform add or 

delete item line action. 

 

 

Upcoming features in Modern View: 

Some features and functions are still being realigned and fine-tuned to the best possible performance to ease your workflow 

and help you to work on the system with ease and comfort. Hence, they will not be made available in Modern view for this 

release.   

Note: Should these features functions be part of your business requirements, we recommend that you continue to enjoy using 

these features and functions under Classic view for the time being until we are ready to ship them in our coming product 

release.   

Those features or functions included: 

• Serial Number • XCOST 

• Quantity Formula • User Define – Formula 

• Unit Price Formula • New set of User Define Menu for Modern View 
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Payment Cloud/Invoice Payments 

In this challenging time, many businesses today are looking out for opportunities to get paid faster on the sales made. Sales 

without prompt collections will put any businesses into a negative cashflow position which will pose a threat on the business 

financial health check. And, to enable their customers can make payment effortlessly, ease, convenience and flexibility are the 

key factors that will help to drive this push. 

In the effort of making payments seamless we have provided new features in Sage UBS to assist our users in better collection 

and their customers to make payment easily and conveniently, with the following capabilities: 

c. Ability to email invoices directly to customers with a payment link where they can conveniently click to make payments 

with various methods  

d. Provide several service providers choices for Sage user to go onboard and start using the facility to ease collection in a 

matter of minutes 

 

1. Customer Journey 

Sage 

Customer 

 

End 

Customer 

 

Sage UBS 

 

Payment 

Provider 

 

 

2. How it works 

 

 

Important Note: This function is tied to your Sage Cover Validation. If your Sage Cover is valid, it will be made available in 

the system for your use.   

 Send invoice 
with Pay button 

Invoice 
Paid 

 Receive Invoice 
with Pay button 

 
Select Payment 

Method 

 
Enter Card 

details 

 
Click Pay 

button 

 
Redirect end customer to 
providers payment page 

 Display invoice 
information and 

payment method 
selection page to end 

customer 

Process 
Payment 
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3. Getting started 

Note: The Payment feature can only be onboarded up to 20 times per license. E.g. You have 40 companies created but 

only 20 companies can be onboarded. 

3.1 Welcome message 

At the login page, users will see a pop-up welcome message introducing the new Invoice Payment feature with contact 

information for Sage to assist our users should they require more information 

 

 

 

3.2  New labels  

To provide better visibility when logging in to Sage UBS, labels indicating the new features are provided so 

that users can navigate through the menus easily to find those said features. 

3.2.1 Accounting 

1. Services 
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  2. Services > Invoice Payment Listing 

 

 

3.2.2 Inventory & Billing 

 1. Administration 

 

 2. Administration > Administrative Tools 

 

3. Administration > Administrative Tools > E-Banking 
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3.3  Service Providers 

In Sage UBS, we offer the following payment service providers for users to choose from: 

1) PayPal 

2) Stripe 

 

3.4 Onboarding process 

As this function is related to invoice payment, the onboarding process will be done only at the Inventory & Billing module. 

3.4.1 Steps 

Module →  Inventory & Billing 

Path  →  Administration > Administrative Tools > E-Banking tab 

Action  →  Select your preferred option “PayPal and/or Stripe”  

 → Click on “Set up Payment Provider” button to start the onboarding process 
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3.4.2  Disclaimer 

Disclaimer for users:  
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3.4.3 PayPal 

Do take note that the onboarding process for PayPal and/or Stripe are placed together. This was structured by our 

Payment Service team for Sage solutions around the world to provide convenience and ease of processing for our 

customers. Users will then need to select either one to sign in or sign up.  

 

1) Sign in with Admin email (First time only)  

 
 

 

2) Select PayPal option 
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3) Connect your PayPal account by entering your credentials 
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4) Sign up for a new merchant account if you do not have an existing account 

 

 

 

5) Log in with your new / existing credentials 

 
 

 

6) Onboarding successful and connection status is displayed 
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3.4.4 Stripe 

 

1) Sign in with admin email (First time only)  

 
 

 

 

2) Select Stripe 
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3) Connect Stripe account  

 
 

 

4) Sign in with existing account or sign up to create a new Stripe account 
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5) Verify your email 
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6) Activate your account 

 

 

 

7) Login to your account 

 
 

 

 

8) Connect your Stripe account 
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3.5  Set up after Onboarding 

Once onboarding is successful, users will be redirected back to the Administrative Tools screen where you will be required 

to perform the necessary settings in Administrative Tools > E-Banking to manage your tasks efficiently.  

 

3.5.1  Payment Providers Management 

 
 

Note: This section is for user to view all Payment Services Providers that were successfully activated. Multiple Payment 

Providers can be activated at the same time or over a period; but only 1 can be in-use at a time. This is to ensure 

the correct payment link is generated for the invoice you will email to your customer. 

 

Tab / Feature Function 

Payment Providers Management • Payment Service Providers successfully activated will be listed here for 

user to manage settings as required on the right panel: 

➢ Bank Acc • map the relevant GL bank account here for the system to update when 

you generate receipt from the payment status screen 

➢ Bank Charges Acc • map the relevant GL account here for the system to update charges 

incurred, where applicable, when you generate receipt from the 

payment status screen 

➢ Status • to see which payment service is active 

➢ In Use • check the box to set default payment service to use in the Pay link 

 

 

  



Sage UBS  ◄22 
   

222222  

 

3.5.2  Payment Link Settings 

 

 

Note: This section is for you to link list of customers to the respective payment service you have activated. Some 

businesses may want to separate different categories of customers to pay under different payment provider and 

this can be easily addressed by checking on the check box to link the customers to the payment provider 

accordingly. 

 

Tab / Feature Function 

Payment Link Settings • to link your customers to the relevant payment service provider for the 

payment link generation. 

Note: Only customers that are selected (checked) will have the Pay 

link embedded in the email received 

➢ Checkbox • Customers maintained in the system will be listed here for user to mark 

/ unmark as per business needs 

Note: Only marked customers will have the payment link 

generated and embedded in the email sent to them for direct 

payment processing  

 

  .  

. 
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3.6  Email Invoice with payment link 

With the current email function in place, we have integrated the payment feature to include the payment link in the 

email itself. This feature is only functional when payment service is active and in-use. As mentioned earlier, this function 

is related to invoice payment and the emailing of invoice will be processed at the Inventory & Billing module 

3.6.1  Select an invoice to email 

- Customer & Sales > Sales Invoices > Create Invoice / Search Invoice 

- Create a new invoice or select a pre-existing invoice  

- Click on the ‘Mail’ icon to bring up the email window 

 
 

3.6.2  Email the Invoice with payment link 

- Check to ensure the option “Include Payment Link” is checked. It is checked by default when feature is active. 

Note: Checkbox can be unchecked by user if payment link is not required in the invoice to be emailed. 

- Click ‘Send’ button to send the email with payment link.  
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3.6.3  Resending Email with updated info 

- Updated info will not be shown if you resend an email until you cancel the previous email. 

- Example: An email with payment link has been sent out, you make changes to that invoice, you will need to cancel 

the previous invoice before sending out the updated version. 

 

 

3.7  Get Paid 

The flow explained on this section will be handled by your customers once they receive the email from you. 

3.7.1  Check email (Customer side) 

Email received by customer will be similar to the screen below: 
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3.7.2  Making payment (Customer side) 

To make payment, customer will click on the green ‘Pay’ button in the email. This button has the embedded link which 

will direct the customer (payer) to the payment service website (PayPal / Stripe) to make the payment online. 

 

 

3.8  Check Status  

After you have sent out the email, you may check on the payment status later at our new Invoice Payment Listing function to 

get the latest updates on the payments. 

 

3.8.1 Invoice Payment Listing 

We have added a new dashboard feature in Accounting module to allow users to view all the related invoices and provide 

comprehensive and updated information on payment statuses. Note: Checking of statuses will be handled in Accounting 

module as the issuing of receipt, knock-off process and AR updates are all managed here.  

Path → Services > Invoice Payment Listing 
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Notes:  

1. In the bottom left corner of the window shows the last updated date and time.  

2. To view new incoming invoices, user must refresh the list.  

3. To refresh the list, user must close the window and reopen it. This step is required to download the latest updates 

 

 

Functions & Features  

• View details of 

invoices 

➢ such as date created, invoice no., amount, status etc. 

• View invoices with 

different status 

➢ by clicking on the status dropdown list and select a different status type and click 

on ‘Show Listing’ button to show the new list 

• Filters ➢ to view or sort invoices by date range, customer/debtor number, invoice number, 

status, and payment service provider 

• View status change ➢ For example, when a user sends out an email with payment link, the status will be 

shown as Pending, and once payment is made, status will change to Paid 

• Cancel payment ➢ by selecting an invoice and click on ‘Cancel Payment’. This will make the sent 

payment link unusable 

• Generating receipts ➢ User can generate receipts by selecting a paid invoice and click on ‘Generate 

Receipt’ 

 

 

Examples of statuses and what they mean: 

 

 

Status type Description 

ALL Show all invoices 

PAID Show invoices that have been successfully paid 

PENDING Show invoices that have been sent out successfully but have not been paid. 

FAILED Show invoices that have failed to send. 

CANCELLED Show invoices that have been sent and then cancelled. 

REFUNDED Show Invoices that have been refunded. 

PARTIALLY_REFUNDED Show invoices that have been partially refunded. 

 

 

Update 

It is important to know that the payment made is processed and handled by the Payment Service Provider outside of 

our system. However, with the ability to pull updates information back to the system, you will be able to proceed to 

update the payment into your accounts by generating the receipt to your customer in the Accounting module.  
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3.8.2 Generate Receipts 

All payments with status “PAID” will have the Generate Receipt function enabled on the bottom of the page. Simply 

click on the button and it will direct you to the receipt screen to process your receipt accordingly 

- Select “PAID” status and invoices that have been paid by customers via the Pay link will be displayed 

- Select a record and click Generate Receipt button to issue receipt to your customer on the paid invoice 

 

 

- System will direct you to the Receipt screen with auto-filled information from the payment link: 

1. Bank A/c No. and Name (only if mapping is done at the setup) 

2. Amount 

3. Debtor A/C No. and Name 

- User is required to manually enter other necessary information like Batch no., Reference number, including Bank 

A/C No. if field is blank due to incomplete mapping at setup 

- After filling in all required fields, user can then click on the Knock-Off button to proceed with the receipt-invoice 

offset process  
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- Once the knock-off process is done, the knock-off details will be displayed on the grid section for your reference 

- Click on the Reverse button to undo the knock-off link between the receipt and invoice 

- Click on ‘Save’ button to save the receipt after verifying all information is correct.  

Note: at this point, your financial entries will be auto generated, and GL accounts updated simultaneously 
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3.8.3 Edit Receipts 

Users can still edit the saved receipt by going back to the Invoice Payment Listing screen and select the receipt listed 

in the Receipt column. Click on ‘Edit Receipt’ button to be directed to the receipt screen to make the necessary 

changes and save the receipt again. 

 

 

  



Sage UBS  ◄31 
   

313131  

Useful Fixes 

No Case ID Brief Description 

1 SAA1-1512 

SAA1-1518 

 

Issue:  

• When using Simplified Chinese or any Chinese character, the UBS new version hits error 

when login 

Resolve:  

• Using Simplified Chinese or other languages, user can successfully log in without any 

error prompted. 

 

2 SAA1-1513 

 

Issue:  

• For some of the machines, in modern view, the menu and font are missing.  

Resolve:  

• Issue is resolved by restarting machine.    

Note: Like any windows update, you may be required to restart your machine to deploy 

the updates. 

 

3 SAA1-1517 Issue:  

• When printing Issue Bill, system was using Windows default printer instead of Sage UBS 

selected printer.  

Resolve:  

• Similar to other transaction (i.e Sales Invoice), system will be using the selected printer in 

Sage UBS to print Issue Bill. 

 

 

******   End   ****** 

https://jira.sage.com/browse/SAA1-1512
https://jira.sage.com/browse/SAA1-1512

